BOOKMARKS
1. To create a ToC using the tools available in Word, you need to ensure you’ve used the proper styles for the document. The image shows the drop-down menu for ToC and the automatic table options (under References tab). 
[image: A screenshot of a computer

Description automatically generated]


2. In styles you’ll find the corresponding terms to match the TOC (under Home tab). 
[image: A screenshot of a computer

Description automatically generated]


3. Check the document to confirm you are using the correct style. Use the Outline or Draft view (under View tab). If a heading you want included in the ToC is labeled ‘Normal’, you’ll need to update the style. It can be updated while in Outline or Draft view by using the styles on the Home tab.
[image: A screenshot of a computer
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4. Use the button mentioned above to create the ToC. If you skipped the steps above, you’ll get a message. Then the ToC box will appear without entries. 
[image: A computer screen shot of a computer

Description automatically generated]

TABLE OF CONTENTS
5. If you used the proper styles, the ToC will appear like this:[image: A computer screen shot of a computer

Description automatically generated]
1. When creating a ToA, you’ll need to mark the citations throughout the document. Under the References tab in the Table of Authorities section you’ll find the Mark Citation button; the dialog box will open as shown. 
[image: A screenshot of a computer

Description automatically generated]

2. Go to the first citation in the document and mark it for the table. Ensure the category matches the type of document, in this instance ‘Cases’ is the correct category. Click Mark, then Next Citation.
[image: A screenshot of a computer

Description automatically generated]

3. For repeat, shorter citations, you’ll do the same process, but you’ll need to match it to the previous full citation, so they all appear correctly in the table of authorities. 
[image: A computer screen with a message box
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4. After you have marked all the necessary citations, you can create the table of authorities. 
[image: A screenshot of a computer
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5. To ensure you have marked all the citations, turn on the Show/Hide (Home tab) and check that all the citations have been marked. 
[image: A screenshot of a computer
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6. Table of Authorities
TABLE OF AUTHORITIES
[image: A screenshot of a computer
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1. To insert bookmarks, put the cursor near the section you want to bookmark (text, picture, location). Click the Bookmark button on the Insert tab.

[image: A computer screen with many different colored icons

Description automatically generated with medium confidence]


2. Next, enter the name of the bookmark and click add. 

[image: A screenshot of a computer

Description automatically generated]

3. Repeat these steps for all the bookmarks you want to add. Then check to ensure the bookmarks go to the proper location. 

a. One way to do this is to click the Bookmark button and choose the name, then click Go To. It should jump to the place you put the cursor when creating the bookmark. 

[image: A screenshot of a computer

Description automatically generated]

b. Another way is to use Ctrl + G. The Find and Replace dialog box will open on the Go To tab. Use the arrow to extend the menu and choose the bookmark you want. Then click Go To. 

[image: A screenshot of a computer

Description automatically generated]

c. An additional way, go to File, Options, Advanced and then scroll to ‘Show document content” and select Show Bookmarks. Brackets will show up on both sides of where you created the bookmark. 

[image: A screenshot of a computer

Description automatically generated]
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For those that missed it this past Sunday, there was a wonderful article in the Buffalo News on the recent Graycliff donation to the University Archives!

The Buffalo News reports that the tale of two houses and Frank Lioyd Wright's 30-year relationship with Darwin and Isabelle Martin are among the history documented in a huge collection of materials that
have gained a permanent home at UB's Special Collections library on the North Campus. “This collection is one of the few olistic views where you can see Wright's work span a period of time between
different properties with the same family,” said UB University Archivist Hope Dunbar. “You can see Wiright develop as an architect and how he worked with clients, as well as how he pushed back with them.”

Hope Dunbar, JD, MLIS
University Archivist

University Archives
420 Capen Hall

University at Buffalo Libraries
Buffalo, NY 14260

(716) 645-2991
library.buffalo.edu/archives/

Special Collections is open to in-person research visits Monday through Friday from 10:00 am to 4:00 pm (with some exceptions). Researchers are strongly encouraged to make an appointment ahead of time and should contact
the Poetry Collection, Rare & Special Books Collection, Robert L. Brown History of Medicine Collection, or University Archives.
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For those that missed it this past Sunday, there was a wonderful article in the Buffalo News on the recent Graycliff donation to the University Archives!

The Buffalo News reports that the tale of two houses and Frank Lioyd Wright's 30-year relationship with Darwin and Isabelle Martin are among the history documented in a huge collection of materials that
have gained a permanent home at UB's Special Collections library on the North Campus. “This collection is one of the few olistic views where you can see Wright's work span a period of time between
different properties with the same family,” said UB University Archivist Hope Dunbar. “You can see Wiright develop as an architect and how he worked with clients, as well as how he pushed back with them.”

Hope Dunbar, JD, MLIS
University Archivist

University Archives
420 Capen Hall

University at Buffalo Libraries
Buffalo, NY 14260

(716) 645-2991
library.buffalo.edu/archives/
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Applications for the 2024 Teaching the Teachers Conference are open through Friday, January 12", To apply, see the link on the conference website.

The 2024 Teaching the Teachers Conference will be held at the University of Pennsylvania Carey Law School in Philadelphia, Pennsylvania from May 30%- 31+ This is a main conference and will
‘contain more advanced topics than the bootcamp conference, which will be held again in 2025. The schedule and program topics are currently available on the conference website.

Conference attendance is limited. We will be accepting 40 attendees from the application process. The conference will cost $150.
The blind application process makes attendance more equitable and gives more people a chance to attend over the years. We will evaluate applications based on the following factors:

Need for training on instruction

Number of years teaching

Institution (preference will be given to librarians from different insitutions, as our hope is that if one person comes from your institution, they will share what they leam with the entire team)
Diversity of library type, level of teaching experience, type of teaching you do, backgrounds (we want a good variety so we have more robust discussion)

« Prior conference attendance (preference will be given to those who have not had a chance to attend before).

If you have any questions about the application process, please contact Alyson Drake at adrake2(@central U edu

Genevieve Tung

Associate Director for Educational Programs
Biddle Law Library

The University of Pennsylvania Carey Law School
gtung@law.upenn.edu
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research and teaching support to faculty, staff, students, and researchers in the Jacobs School of Medicine and Biomedical Sciences. This hire will join the current Jacobs School |

ison in building strategic partnerships

‘within the school through collaboration with faculty and researchers while also providing support to a wide audience of undergraduate, graduate, residency, and fellowship programs.
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Jesse

Jesse Meyer, PHR, SHRM-CP (Pronouns: He/Him/His)

Human Resources Manager
University Libraries

University at Buffalo, State University of New York

433A Capen Hall
Buffalo, New York 14260
Phone: 716.645.1318 | FAX: 716.645.3844
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primary- residence.html
1910 Indeed, since the outbreak of Covid-19 in early spring, followed by the recent protests against racism and
police brutality, Trump has understandably remained in the White House for longer periods of time than ever before
during his Presidency. See Aamer Madhani & Darlene Superville, As Trump Resumes Travel, Staff Takes Risks to
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UB IN THE NEWS

USA Today quoted David

Schmid, associate professor in

usa
730ay

the Department of English, in a
Story about the nation’s true-crime
obsession with Gypsy Rose Blanchard, who
rose to social media stardom after wrapping
up a prison sentence for murder for
conspiring with her then-boyfriend to kill her
mother.

WBEN-AM spoke with Leslie

Bisson, UB sports medicine

o

that contributed to

surgeon, who leads the team

* safety Damar
Hamlin's recovery after suffering cardiac
arrestin a game last January. Bisson
received funding to increase bystander
CPRIAED training in underserved

communities in Buffalo.

Quote of the Day

“Beyond the architect and the design, we see the social history

of the home.”

Sarah Cogley, digital archivist for the UB Archives, which will house a collection of historic

objects from Grayciif, the summer home designed by Frank Lioyd Wright for Darwin D. and

Isabelle Martin. Read the full story
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(2) Unless othenwise directed by the court, each electronically-submitted memorandum of law, affidavit and affirmation, exceeding 4500 words, which was prepared with the use of a computer software
program, shall include bookmarks providing a listing of the document's contents and facilitating easy navigation by the reader within the document

(b) Submission of Papers to Judge. All papers for signature or consideration of the court shall be presented to the clerk of the trial court in the appropriate courtroom or clerk's office, except that where the clerk
is unavailable or the judge so directs, papers may be submitted to the judge and a copy filed with the clerk at the first available opportunity. All papers for any judge that are filed in the clerk's office shall be
promptly delivered to the judge by the clerk The papers shall be clearly addressed to the judge for whom they are intended and prominently show the nature of the papers, the title and index number of the
action in which they are filed, the judge's name and the name of the attorney or party submitting them.

(c) Papers filed to commence an action or special proceeding. For purposes of CPLR 304. governing the method of commencing actions and special Proceedings. the term "clerk of the court” shall mean the
‘county clerk. Each county clerk, and each chief clerk of the Supreme Court_ shall post prominently in the public areas of his o her office notice that filing of papers in order to commence an action or special
proceeding must be with the county clerk. Should the county clerk, as provided by CPLR 304, designate a person or persons other than himself or herself to accept delivery of the papers required to be filed in
order to commence an action or special proceeding, the posted notice shall so specify.

20270
Rule 6. Form of Papers.

(a) Al papers submitted to the Commercial Division shall not be inconsistent with CPLR 2101and section 202 5(a). Papers shall be double-spaced and contain print no smaller than tweive-point, or 8% x 11
inch paper, bearing margins no smaller than one inch. Unless otherwise directed by the Court or provided in the Court's individual rules, all text in briefs and affidavits, including footnotes, shall use
proportionally spaced 12-point serif typeface. Papers also shall comply with Part 130 of the Rules of the Chief Administrator. Each electronically-submitted memorandum of law and, where appropriate, affidavit
and affirmation shall include bookmarks providing a listing of the documents contents and facilitating easy navigation by the reader within the document

(b) For purposes of this Rule, a hyperlink means an electronic link between one document and another, and a bookmark means an electronic link permitting navigation among different parts of a single
document. Material made accessible by hyperlinking does not thereby become part of the record, and citations to authorities shall appear in standard citation form, even if also hyperlinked.

(c) Each electronically submitted memorandum of law o other document that cites to another document previously filed with NYSCEF shall include a hyperiink to the NYSCEF docket entry for the cited
document enabling access to the cited document through the hyperiink_Hyperlinks may not provide access to documents filed under seal or otherwise not in the public record. Cited documents filed with
NYSCEF that are accessible through bookmarks in the electronically submitted document need not also be hyperiinked.

(1) The Court may require that electronically submitted memoranda of law include hyperiinks to cited court decisions, statutes, rules, regulations, treafises, and other legal authorities in either legal research
databases to which the Court has access or in state or federal govemment websites. If the Court does not require such hyperiinking, parties are nonetheless encouraged to hyperlink such citations unless
otherwise directed by the Court

(2) It party certifies in good faith that it cannot include hyperlinks as required by this Rule or the Court without undue burden, due to limitations in its office technology or other showing of good cause, the
Court may excuse the party from any otherwise applicable hyperiinking requirement.

(d) Interlineation of Responsive Pleadings

(1) For every responsive pleading, the party preparing the responsive pleading shall interlineate each allegation of the pleading to which it is responding with the party’s response to that allegation, and in doing
50, shall preserve the content and numbering of the allegation

(2) The party who prepared a pleading to which a responsive pleading is required shall, upon request, promptly provide a copy of its pleading in the same word processing software application in which the o
pleading was prepared to the party preparing the responsive pleading
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(2) Unless othenwise directed by the court, each electronically-submitted memorandum of law, affidavit and affirmation, exceeding 4500 words, which was prepared with the use of a computer software
program, shall include bookmarks providing a listing of the document's contents and facilitating easy navigation by the reader within the document

(b) Submission of Papers to Judge. All papers for signature or consideration of the court shall be presented to the clerk of the trial court in the appropriate courtroom or clerk's office, except that where the clerk
is unavailable or the judge so directs, papers may be submitted to the judge and a copy filed with the clerk at the first available opportunity. All papers for any judge that are filed in the clerk's office shall be
promptly delivered to the judge by the clerk The papers shall be clearly addressed to the judge for whom they are intended and prominently show the nature of the papers, the title and index number of the
action in which they are filed, the judge's name and the name of the attorney or party submitting them.

(c) Papers filed to commence an action or special proceeding. For purposes of CPLR 304. governing the method of commencing actions and special Proceedings. the term "clerk of the court” shall mean the
‘county clerk. Each county clerk, and each chief clerk of the Supreme Court_ shall post prominently in the public areas of his o her office notice that filing of papers in order to commence an action or special
proceeding must be with the county clerk. Should the county clerk, as provided by CPLR 304, designate a person or persons other than himself or herself to accept delivery of the papers required to be filed in
order to commence an action or special proceeding, the posted notice shall so specify.

20270
Rule 6. Form of Papers.

(a) Al papers submitted to the Commercial Division shall not be inconsistent with CPLR 2101and section 202 5(a). Papers shall be double-spaced and contain print no smaller than tweive-point, or 8% x 11
inch paper, bearing margins no smaller than one inch. Unless otherwise directed by the Court or provided in the Court's individual rules, all text in briefs and affidavits, including footnotes, shall use
proportionally spaced 12-point serif typeface. Papers also shall comply with Part 130 of the Rules of the Chief Administrator. Each electronically-submitted memorandum of law and, where appropriate, affidavit
and affirmation shall include bookmarks providing a listing of the documents contents and facilitating easy navigation by the reader within the document

(b) For purposes of this Rule, a hyperlink means an electronic link between one document and another, and a bookmark means an electronic link permitting navigation among different parts of a single
document. Material made accessible by hyperlinking does not thereby become part of the record, and citations to authorities shall appear in standard citation form, even if also hyperlinked.

(c) Each electronically submitted memorandum of law o other document that cites to another document previously filed with NYSCEF shall include a hyperiink to the NYSCEF docket entry for the cited
document enabling access to the cited document through the hyperiink_Hyperlinks may not provide access to documents filed under seal or otherwise not in the public record. Cited documents filed with
NYSCEF that are accessible through bookmarks in the electronically submitted document need not also be hyperiinked.

(1) The Court may require that electronically submitted memoranda of law include hyperiinks to cited court decisions, statutes, rules, regulations, treafises, and other legal authorities in either legal research
databases to which the Court has access or in state or federal govemment websites. If the Court does not require such hyperiinking, parties are nonetheless encouraged to hyperlink such citations unless
otherwise directed by the Court

(2) It party certifies in good faith that it cannot include hyperlinks as required by this Rule or the Court without undue burden, due to limitations in its office technology or other showing of good cause, the
Court may excuse the party from any otherwise applicable hyperiinking requirement.

(d) Interlineation of Responsive Pleadings

(1) For every responsive pleading, the party preparing the responsive pleading shall interlineate each allegation of the pleading to which it is responding with the party’s response to that allegation, and in doing
50, shall preserve the content and numbering of the allegation

(2) The party who prepared a pleading to which a responsive pleading is required shall, upon request, promptly provide a copy of its pleading in the same word processing software application in which the o
pleading was prepared to the party preparing the responsive pleading
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You are very welcome!

Thank you! You too!

You are welcome, and thank you!

@ Feedback

Hi Latasha,

‘Thank you SO much for this information and for the masks!!! And my husband, Greg, thanks you as well!

Have a nice weekend!
Nina

From: Latasha Towles <ltowles@buffalo.edu>
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Te purchased from this site 2 couple of times and had no issues. You can use FSA, but you might have to get 2 teimbursement because I don’t remember if they take the cards directly.

Te also purchased from amazon, but only if it says “Ships from: Amazon, Sold by: Amazon”; here’s 2 links for 2 listing. You can also use FSA on amazon.

Hope this helps!

Latasha R Towles

Law Practice Technologist
Charles B. Sears Law Library
University at Buffalo School of Law

211 O’Brian Hall
Buffalo, NY 14260
(716) 6452050
Itowles@buffalo edu
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Create a keyboard shortcut

1. On the Tools menu, select Customize Keyboard.
2. In the Categories list, select a tab name.

3. In the Commands list, select the command that you want to assign a keyboard shortcut to.
Any keyboard shortcuts that are currently assigned to the selected command will appear in the

Current keys box.

Tip: If you prefer to use a different keyboard shortcut, add another shortcut to the list, and then use it
instead.

4. In the Press new keyboard shortcut box, type a key combination that includes at least one modifier
key (, CONTROL, OPTION , SHIFT ) and an additional key, such as + F11

If you type a keyboard shortcut that is already assigned, the action assigned to that key combination
appears next to Currently assigned to.

5. Select Add.

Note: Keyboard shortcut descriptions refer to the U.S. keyboard layout. Keys on other keyboard
layouts might not correspond to the keys on a US. keyboard. Keyboard shortcuts for laptop
computers might also differ.

Delete a custom keyboard shortcut

1. On the Tools menu, select Customize Keyboard.

2. In the Categories list, select a tab name.
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The LSRD-SIS distributes a MARG record and link for a legal-related Website of the Month as a service to all AALL members. For more information and a listing of previously distributed websites,
please go to wvw aallnet org/lsrdsis/resources-publications/... Many thanks to Chi Song for updating the Website of the Month and to Jennifer Noga for continuously updating the lists!

This month's site is Tebtebba

Tebtebba (Indigenous Peoples' Intemational Centre for Policy Research and Education) established in 1996, is an indigenous peoples' organization and works for the respect, protection and
fulfilment of indigenous peoples' rights and their self-determined sustainable development. Tebtebba takes the lead in policy advocacy and campaigns on allissues afecting indigenous peoples
and seeks to promote and disseminate widely indigenous peoples worldviews, their perspectives on key issues such s individual and collective human rights, sustainable development, climate
change, biodiversity, traditional knowledge, customary laws and govemance, conflict transformation, gender, etc.

You can view the bibliographic record for this website in the University of Hawaii Law Library's catalog at

uhawaii-law.primo exlibrisgroup. com/discovery!

altemately go to uhawaii-law.primo.exiibrisqroup.comydiscovery/

and

execute a title search by Tebtebba Indigenous Peoples' Intemational Centre for Policy Research and Education

Finall, if you have encountered (and especially if you have cataloged) a particularly useful or interesting website that you would like to share via the Website of the Month, please email me at

keikooku@hawaii.edu

Happy New Year to Al

Keiko Okuhara
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